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PRO-Diary Motion Regulatory Information

Medical Device Directive (European Union)
The PRO-Diary Motion is a Class | Medical Device conforming to the essential safety
& health requirements and provisions of EC Council Directives 93/42/EEC, Annex
VII. An EC declaration of Conformity will be provided upon request.

US FDA status
The PRO-Diary is FDA cleared for prescription use only with FDA 510(k) number

K132764.
Manufacturer:
CamNtech Ltd Tel: 01480 831223
Upper Pendrill Court Fax: 01480 831733
Papworth Everard Email: technical@camntech.co.uk
Cambridgeshire Web: www.camntech.co.uk
CB23 3UY, UK

Australian Sponsor:

Please note that the sponsor should be contacted ONLY to report adverse events —
all sales and support issues must be directed to CamNtech in the UK.

Emergo Australia
Level 20

Tower Il, Darling Park
201 Sussex Street
Sydney, NSW 2000
Australia

Applicable Standards:

The appropriate clauses of the following standards have been used as a means of
demonstrating compliance.

Standard Description

EN60601-1:2006 Medical electrical equipment — Part 1: General requirements for basic
safety and essential performance.

EN60601-1-2:2007 Medical electrical equipment — Part 1-2: Collateral standard:
Electromagnetic compatibility — Requirements and tests.

See Appendix C for declaration and guidance

EN60601-1-11:2010 Medical electrical equipment — Part 1-11: Collateral standard:
Requirements for medical electrical equipment and medical electrical
systems used in the home healthcare environment.

EN60601-1-6:2010 Medical electrical equipment — Part 1-11: Collateral standard: Usability

EN62304:2006 Medical device software — Software life-cycle processes
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IMPORTANT SAFETY INFORMATION

WARNINGS

o Not Defibrillation proof.
A e Not indicated for use on areas of broken, damaged or irritated skin.

e Devices removed from subjects must be considered to be contaminated — see SECTION12.

Safety Classification Information:

e PRO-Diary Motion is INTERNALLY POWERED EQUIPMENT.

e PRO-Diary Motion mode of operation is CONTINUOUS OPERATION.

e PRO-Diary Motion is for PRESCRIPTION USE ONLY (Ry only) in the USA

Device and Packaging Symbols and Markings:

MEANING SYMBOL

DESCRIPTION

General Warning

A

Potential hazard - refer to the warnings in the instructions
for use (i.e. this user guide).

Consult Instructions for Use ‘ '

This symbol indicates that important operational
information is contained in the user instructions (i.e. this
user guide).

Ingress Protection Rating

P42

The PRO-Diary is not suitable for immersion in water
(splash-proof — avoid contact with liquids if possible).

Serial Number

SN

This number provides a unique identification for a particular
device. Always quote this number when seeking technical
assistance.

Catalogue Number

REF

This number identifies this particular variant of the product
range.

Manufacturer and Date of
Manufacture

il

This symbol is accompanied by a date in the format yyyy-
mm which indicates when the device was manufactured.
The symbol is also accompanied by the address and
contact details of the manufacturer

Electrical Safety
Classification

The PRO-Diary is a TYPE B APPLIED PART.

(Internally Powered — no mains connection)

FOR FURTHER HANDLING & ENVIRONMENTAL INFORMATION PLEASE REFER TO SECTION 12
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1 Introduction to the PRO-Diary System

1.1 An Overview of the PRO-Diary System

The PRO-Diary system consists of a wrist-worn electronic patient diary and
associated PC software which can record the user’s answers to questions during
daily living in a very flexible and easy to use way. The PRO-Diary incorporates a
tri-axial accelerometer to allow objective actigraphy data to be collected while the
device is worn. Actigraphy data may be saved and loaded into the CamNtech
MotionWare Software for off line analysis. The device is intended to monitor
limb or body movements during daily living and sleep. The PRO-Diary can be
used to assess activity in any instance where quantifiable analysis of physical
motion is desired.

The PRO-Diary has a built-in score pad that allows the wearer to subjectively
assign and enter responses to pre-programmed questions. The score pad can be
used as a substitute or in addition to the traditional written patient diary in
conjunction with activity monitoring.

The PRO-Diary system comprises of:

e One or more PRO-Diary devices — to be worn or carried by the subject
e PC software for designing questionnaires, setting-up, downloading,
viewing and exporting recorded answers

The PRO-Diary has a direct USB connection for setting up, downloading and
charging the battery. See Section 3 for details of battery charging and expected
life.

The PRO-Diary has a clear, high contrast OLED display and the character size
may be changed during configuration. The front panel keys are touch sensitive
and require no force to operate. There are three main controls: the function key
which has multiple functions, the select key which is generally used to choose a
selection and slider control which allows precise item selection by means of left
or right swiping movements.

OLED Display ‘Select’ Key

‘Function’ Key \.

Slider Control
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1.2 Indications For Use
The PRO-Diary is a compact, lightweight, body-worn activity monitoring device
that may be used to document physical movement associated with applications
in physiological monitoring. The device is intended to monitor limb or body
movements during daily living and sleep. The PRO-Diary can be used to assess
activity in any instance where quantifiable analysis of physical motion is desired.
The PRO-Diary has a built-in score pad that allows the wearer to subjectively
assign and enter responses to pre-programmed questions. The score pad can be
used as a substitute or in addition to the traditional written patient diary in
conjunction with activity monitoring.

1.3 Contraindications
The PRO-Diary Motion is indicated for use on healthy, undamaged areas of skin.
Where the patient has a history of skin irritation, a device should be worn for a
brief period to test for skin irritation prior to commencing any recording.

1.4 Required Skills, Training & Knowledge of Intended Users.
It is intended that the device be administered only by duly qualified health care
professionals, researchers and or trained nursing staff, possibly in a hospital
environment.

1.5 General Description of Use
The PRO-Diary Motion provides patient diary functionality by means of PC
software based questionnaire configuration and upload to the device. The device
will automatically prompt the subject for input at pre-defined intervals or,
depending upon configuration, upon user request. The responses to the
questions are recorded to internal non-volatile memory and the date may then be
downloaded using the PC software. The resulting data may be exported for
further analysis in third party software packages.

The PRO-Diary Motion contains a miniature accelerometer to allow
measurement and recording of physical movement of the wrist which provides a
close correlation to whole body movement. The data are sampled at 50Hz and
processed into ‘epochs’ of user selectable length. These data are stored into an
internal non-volatile memory and then downloaded for analysis at the end of the
study period. Activity data recorded by the PRO-Diary may be analysed off-line
using the MotionWare Software Package.
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2 Installing the PRO-Diary Software

2.1 System Requirements

The PRO-Diary software is supplied on a CD-ROM containing all of the
components required to install the software package. The following are the
minimum requirements of a host PC for installing the PRO-Diary software:

= Windows XP, Vista, Windows 7 or 8, 32 or 64bit operating systems.
= |IBM compatible 2GHz + processor speed recommended

= 500 MB hard disk space

=  One free USB port

= A CD-ROM or DVD drive for software installation

= Graphics SVGA(1280 x 1024) recommended

In general, a faster processor will provide superior performance.

2.2 Software Installation Menu

Place the CD-ROM into the drive; the software should start automatically and
display the following installation menu:

r Al
Install CamNtech PRO-Diary Software... &J

Install PRO-Diary PC Software
Manually Install CamNtech USB Drivers
Software Training Videos

[Obtain .NET from Microsoft website instead)]

|

To install the software, click on ‘Install PRO-Diary PC Software’ and follow the
installation process. Note that the installation will differ for new users and existing
users as described in Section 2.3 below.

A message warning that ‘Publisher cannot be verified’ may be displayed — click
‘Run’ to accept. (this is a Windows security warning and is not a problem).

If the above menu is not automatically displayed, browse the CD and run the file
‘SplashMenu.exe’.

Note that the software requires the Microsoft .NET Framework 4 to operate — this
will be automatically installed if not present.
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2.3 Users upgrading from an earlier version of the Software

Upon following the procedure described in Section 2.2, users upgrading older
versions of software may be asked if they wish to repair or remove the existing
version of the software when the new software installation is run for the first time.
The option to remove should be selected and then the software installation run
for a second time to install the new version as described in Section 2.2.

A message warning that ‘Publisher cannot be verified’ may be displayed — click
‘Run’ to accept. (this is a Windows security warning and is not a problem).

2.4 Installing the USB Drivers

If the Installation menu is not already displayed, insert the supplied CD ROM into
the CD/DVD drive on the host PC then connect the PRO-Diary to a free USB
Port using the cable provided. The Installation menu should be automatically
displayed (as shown in Section 2.2).

Depending upon the operating system in use and the current driver status, the
computer may display a message saying ‘Found New Hardware’ and will then
load the drivers with no user intervention. If the drivers loaded automatically,
simply close the installation menu and the drivers should be ready to use.

If the drivers do not load automatically, you should select ‘Manually Install
CamNtech USB Drivers’ and carefully follow the on-screen instructions. If you
have any problems installing the drivers, please read the help document and
download the latest drivers from http://www.camntech.com/drivers.

During manual installation, a screen may appear that tells the user that the driver
is not digitally signed by Microsoft. Select ‘Continue Anyway’ (Please note that
this is NOT a problem and just means that the CamNtech version of the driver
software has not been assessed by Microsoft. In fact the actual drivers are
Microsoft approved). The drivers will be installed and the computer will then tell
the user that the new hardware is ready to use. If you change the USB port that
the reader is plugged into then the driver may be automatically re-installed by
Windows. This is an automatic process and the user need take no action.
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2.5 Using the software for the first time

Double clicking on the PRO-Diary icon on the desktop will start the software.
This will display the main menu as shown below. Each option is introduced in a
section of this guide.

EDIT QUESTIONNAIRES

Create or edit questions, questionnaires Q3 PRO-Diary PC Software (Version 1.0.10)
and schedules. b
See Section 4 File™\Diary  Help
Edit Questionnaires
\\. -
Apply the questionnaire to the PRO-Diary Set Up a Dlary

with various use options.

S / Download Results
[ commewmms [ e

Read the stored answers and activity data
from the PRO-Diary.
See Section 7

OPEN RESULTS VIEWER

View and export the answers and activity
data.
See Section 8
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3 Charging the PRO-Diary Battery

The PRO-Diary contains a lithium polymer rechargeable battery. The life of the
battery is very dependent on usage of the unit — more frequent and longer
guestionnaires will be more demanding. However it should be at least 30 days in
commonly expected uses.

Before the Diary can be used, the user must ensure that it is fully charged.
You may charge it directly from the PC, from a mains power supply or from a
separate USB hub. It will typically take around 3-4 hours for the PRO-Diary to
be fully charged.

3.1 Charging the Diary from the PC

Connect the Diary to a free USB port of the PC and it will be automatically
charged from the PC. If you connect multiple Diaries to the same PC at the
same time, windows will attempt to find extra drivers. This will generate
windows/warnings which can be safely cancelled. You may only communicate
with a single Diary but as long as your PC is capable of it, several should charge
together.

Note that many PC’s have power saving functions which may shut down the USB
ports after a period of time; this will stop the diary charging until normal operation
is resumed. If you any issues related to charging or battery life, we recommend
using a mains power supply for charging to avoid this issue.

3.2 Charging the Diary using the Mains Power Supply

The PRO-Diary may be recharged using a mains adaptor with a standard USB
power output (the type often used for charging MP3 players or phones). Please
ensure any such adaptor is safety approved to EN60950-1 and EMI standard
EN55022 (also FCC part 15, Class B for the USA).

1. Select and fit appropriate ac input socket adaptor for country of use.

2. Plug the USB cable from the Diary directly into the USB socket on the
mains power supply adaptor.

3. The Diary will be automatically charged.

CamNtech can supply a suitable mains power supply if required — please contact
your local distributor.

3.3 Charging Several Diaries from a USB Hub

A USB extension hub may be more convenient to charge several PRO-Diary
devices at once without requiring a PC to be connected. This hub must be
powered by a separate mains adapter itself. CamNtech have tested the PRO-
Diary with a Belkin 4-Port Hub; other hubs with a separate mains adapter are
also likely to work, but CamNtech have not tested against them.

CamNtech can supply a suitable powered USB Hub if required — please contact
your local distributor.
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4 Creating and Editing Questionnaires

4.1 Basic Concepts

The Diary is set up using a combination of questions, questionnaires, and
schedules. It is easiest to familiarise yourself with these by exploring the
examples included with the PC software. After clicking on ‘Edit Questionnaires’
in the main menu, you will be presented with the quick view window, as shown in
the example below. You can explore this tree by right-clicking or double clicking
on various items to get an idea of how the system operates.

& Questionnaire Management

File Edit Add Help

Question database: C:\Documents and Settings\Tom Evans\Application
Data'\Patient Diary\Copy of Questions.mdb

-1 35 All schedules
+ @ Japanese test
=] @ Simple sleep monitoring
+ Daytime sleepiness check
- Morming
? What time did you walke up this moming?
? Why did you wake up?
? How would you rate your quality of sleep?
+ Weeldy review
+ @ Weekday only sleep monitoring
+ B2 Al questiornaires
=% Al questions
Are you intending to catch up on sleep overthe weekend?
Do you feel very tired, or very alert?
Have you had difficulty staying awake in the last few hours?
How would you rate your quality of sleep?
How would you rate your sleep for the last week overall?
Nexd week, do you think you will get more sleep?
Why did you wake up? View
Y SFEEABLNITINT [ create cony
BEM A BOEE%

wxdesJenJenJenJendenden e o]

Delete

Sampl EBlue indicates that the item is still unlocked. Black (locked)
SE items cannot be edited, but can be copied and then changed.

It may be useful to clarify the terminology used in programming the Diary:

The diary presents the user with questions, either at specific times or when the
wearer requests it, and logs their answers. ‘questions’ are grouped together into
‘guestionnaires’, and a ‘schedule’ instructs the diary when to offer each
questionnaire to the wearer.

A ‘question’ is the basic question presented to the wearer. It may be one of half
a dozen basic types, and includes the question itself and various optional
answers, or default settings for entering numbers, times, etc.

A ‘questionnaire’ is a sequence of questions. It may, optionally, include more
complicated instructions for skipping or jumping around in the sequence
depending on the answers to some questions.
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A ‘schedule’ is a list of schedule entries, each with a time and day, that tell the
diary to do something at that time. These may prompt the user, or simply make
available a user-requested questionnaire during a given period. They may also
apply to ‘every Tuesday’ or ‘every weekday’ rather than a specific day.

It will be easiest to set up your first test recording using one of the example
schedules provided, rather than having to create your own first.

4.2 Questions
There are eight types of questions:

e Multiple choice
¢ Visual analogue
e Enter a number
e Enter atime

e Just a message
e List

e Free Text

o Likert Scale

All types include a main ‘question’ message, but a selection of different answer
mechanisms.

Multiple Choice
For example: “Which fruit do you prefer?”, with possible answers of “Apples”,
“Oranges”, or “Other”.

r

ich fruit do you prefe

Apples

11000000000
A v

Each question has 1-8 answers. The user positions the slider directly by tapping
or dragging, and the chosen answer is taken from this. The currently selected
answer is displayed at the bottom of the screen just above the slider bar. This is
the easiest way to question the user for up to around 5-6 answers, but above that
the list may be less fiddly to operate.
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Visual Analogue

Enter a Number

For example: “How difficult is it to touch your toes?”, with the text “Easy” at the
left hand end of the slider bar and “Hard” at the right hand end.

“to touch your toes”

P ET

1100000000on
A v

The user positions the slider directly wherever they feel is appropriate between
the two ends. These ends are described by extra prompts, displayed just above
the slider bar. Ideally these should be short enough to fit at each end of the bar
with a gap in the middle. If it is longer than that it will be repeatedly scrolled
through, but this is not ideal.

For example: “What is your weight in kilograms?”, with the answer 53 displayed
below and a range up to 120.

seight in kilograms®

IP1

1100000000on
A v

The user drags the slider left or right to change the displayed number until they
are happy with the answer. They may also hold it at either end to scroll up or
down continuously.

Questions include a default value, decimal point position, and minimum and
maximum values. The decimal position specifies how many digits to include after
the decimal point. When you are editing an ‘Enter a number’ question, a
message will be displayed explaining the current meaning of your settings.
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Enter a Time

Just a Message

For example: “What time did you wake up this morning?”, with a time of “07:07”
displayed.

Wihat time did you w

[ f o= ] 4
S -

1100000000on
A v

This functions similarly to ‘Enter a number’, except as the user drags the slider
the displayed time changes. They can move it until they are happy with the
displayed time, to an accuracy of 1 minute in 24 hours. Dragging off the
beginning or the end of the 24 hours results in the time wrapping round. The
Diary automatically starts with the current time when the question is asked.

For example: “Please take one blood pressure pill now” with no additional
information or prompt.

e Fleaze take one blo

1100000000on
A v

No extra parameters are needed, and no answer may be selected. The main
guestion is simply displayed in the middle of the screen until OK is pressed.
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List

Free Text

For example: “What activity are you doing right now?” with a list of 20-30 activity
types to select from.

/ou doing right now?

I)1

Funning

1100000000on
A v

The Diary will display the question along with part of the list and a scrollbar to
indicate the user can scroll up or down the list by dragging their finger on the
slider. They may also hold their finger at either end for a period to scroll
continuously. This interface makes it much easier to present a larger number of
options, but is a little more complex for simple questions. It cannot be combined
with the large text setup option, as the screen of the Diary is not large enough.

For example: “What did you just eat?” with the ability to type in any text as an
answer.

This is much slower to input than any other question type, but may be invaluable
if you really need to capture any possible answer to a single question.

The Diary will present the question along with a compressed alphabet. To select
a letter, place your finger approximately under that letter. The alphabet will begin
zooming in. Keep ‘steering’ your finger onto the correct letter as it zooms. Once
a box appears around the letter, you can release your finger and the letter will be
added to your answer. If you become confused when zooming in, simply release
your finger early to cancel. If you do enter an incorrect letter then simply select
the symbol to the left of the main alphabet, ‘DEL’, to delete the previous letter.

Because the free text entry is considerably slower and more difficult to operate

than other question types, you should only use it if necessary and if you believe
your target population will be comfortable with it. You will need to demonstrate
the free text entry to users before they can operate it.
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Likert Scale

4.3 Questionnaires

4.4 Schedules

For example: “How much do you like fruit?” with a scale of five answers.

Haowy much da syau il

<& 3 ot
3 4 5

110000000000
A v

This allows the user to select from a numerical scale, whilst also attaching a
small text description to each level. The text is displayed above the selected
number scale similarly to a multiple choice question, but with the addition of the
highlighted number display below.

A gquestionnaire can simply be a list of questions, in the order they should be
asked. The user will be asked the question at the top of the list first, and proceed
down the list one by one. This is all that is required if the user should be asked
all of the questions every time.

Simple questionnaires can be designed for the PRO-Diary by dragging questions
from the available list at the bottom of the window into the main list. The
questions can be placed directly where they are wanted in the sequence, or re-
ordered later by dragging them up or down the list. To remove a question, simply
drag it back onto the available list below.

It is also possible to design questionnaires with more complex sequencing once
the ‘advanced mode’ of the questionnaire editor is enabled. The question
sequence may then be modified by the user’s answers to a multiple choice
question. In this case, each alternative answer to the that question may have a
different following question number attached to it. This allows a ‘detail’ section to
be skipped if it is not relevant. This is described in more detail in section 4.8.

A schedule consists of a list of schedule entries, and an optional motion logging
configuration. Each schedule entry makes a questionnaire available at a certain
time or times, either prompting the user or simply being available on the menu
when the unit is woken. Every entry consists of a questionnaire, a day
designation, and time/type of entry.
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Day Designation

Time/Type of Entry

Motion Logging

Each entry is applied on certain days, chosen from the options below. Thus, any
single schedule entry may cause the Diary to act on many days throughout a
month’s recording rather than just one.

o Every day

o Every weekday

e Every weekend day

o Every Monday, Tuesday, ... or Sunday
¢ Day n of the recording (n from 1 to 30)

Entries may be marked to prompt the user either at a fixed time, or at a randomly
allocated time within a certain period. This can be used to avoid consistently
prompting at exactly the same time every day, when the user might normally be
busy or begin to expect the prompt.

Entries may also be marked as ‘On request’ during a period of time. This means
that if the user wakes up the Diary at any time during that period then they can
choose to answer the questionnaire at that time, rather than waiting for an alarm.
They can then for example tell the Diary that they have woken up, eaten, or
intend to go to bed now.

Motion logging may be enabled as part of the schedule. This will cause the Diary
to record how much it is moved throughout the day, logging at a chosen “epoch”
interval of between 1 and 60 seconds. The resulting data can be used to monitor
sleep or daytime activity profiles, and analysed using the CamNtech MotionWare
software package.

The “MotionWatch-compatible counts” mode records movement in a measure
compatible with CamNtech “MotionWatch” products. This measure is well
validated for sleep monitoring, and has been used for daytime activity monitoring
also. In future updates an additional mode refined for activity intensity monitoring
may be introduced.

45 Locked and Unlocked Items

When an item has just been created (either a question, questionnaire or
schedule), it is considered to be ‘unlocked’. It will remain unlocked as you edit it
and combine it with other items. When you first use an item when setting up a
Diary, all the used items will be locked. This is necessary so that you have an
accurate record of exactly what went into setting up each Diary, in order to
interpret the data downloaded from it. If you subsequently decide you did not
want exactly the same setup, but a slight variant on it, you must right click and
‘Create Copy’ to create a new unlocked copy with a slightly different name. This
copy can then be modified. This allows you to keep track of your progress with
modified options, as each one is stored separately with a version number tagged
on the end of the item name.
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4.6 Creating a New Question Database

When you want to begin work on your own set of questions and schedules, you
can create a new database file to contain these. This way it will not be cluttered
up by the examples or any questions you have previously created for a different
purpose. To do this, use the ‘File -> New Question Database...’ option in the
quick view window. You can later switch between question databases using ‘File
-> Open Question Database...”. Your current database file is also shown in the
quick view window.

4.7 Diary Menu Customisation

There is an option in the File menu of the quick view window for menu
customisation. This allows you to change the text shown by the Diary during
common actions. You can use this to translate the menu text of the Diary to a
different language. You can also use it simply to clarify or slightly change the
English messages if you wish. Once you have created a set of menu
customisations using this option, you must select one from the drop down list
when setting up a Diary in order to make use of it.

4.8 Conditional Questionnaire Sequences

Quick Summary

Simple questionnaires can be designed for the PRO-Diary by dragging questions
to and from the available list. The questions will always be asked one after the
other from the top to the bottom. They can be re-ordered by dragging them up or
down the list. However, it is also possible to design questionnaires with more
complex sequencing once the ‘advanced mode’ is enabled. This section
describes how to create and modify questionnaires with different sequencing.

e Select a question to see its answers

e Each answer has an arrow showing which question will then follow if that
answer is chosen

e Drag an answer to a different place in the questionnaire to create a link
for that answer

¢ Do this for as many answers as you want to

e |If you want all answers to lead to the same place, drag the ‘- Drag here to
redirect all answers —' item

¢ If you want to remove your links, so all answers just lead to the question
below, press the button for ‘Clear links from this question’

e A sequence of questions can be marked for random ordering, but only if
there are no conditional links within them.

Note that:

e You can only create a split in the sequence using a multiple choice
guestion, because only these have several different answers

e Small arrows will be added to the side of the question list whenever an
answers leads anywhere except the question below

e You can drag answers to just below the bottom of the list to direct straight
to the end of the questionnaire
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Simple example (to omit some questions depending on a previous answer)
In the first example, we show how to make a part of the questionnaire optional,
depending on the answer to a question. First, drag all the questions you want
into the questionnaire. An example with four questions is shown below, with the
second guestion selected:

& Editing new Questionnaire |Z| |E| El |

Questionnaire Name: |Check pain/activity

Question Sequence: (drag guestions up or down, or back into the "available’ box below)  Help with conditional sequences

How severe was the pain? /

Hawve you been very active?

- Drag here to redirect all answers -

Clear links from this guestion

Lorailable Questions: (drag questions from here into the sequence above to use)

 you been very active?
Have you experienced any pain today?
How are you feeling right now?
How severe was the pain?

Create New GQuestion. ..

[v Ensble advanced mode (for conditional seguences)

Save Questionnaire Cancel

You can see the question ‘Have you experienced any pain today?’ is highlighted,
and a box is displayed to its right including the answers ‘Yes’ and ‘No’ from that
guestion. Both of these answers have arrows leading from them to the next
question in the main list. This means that giving either answer will lead to the
same following question, which is always the default. However, we would like to
omit the next question if the answer is ‘No’.

Move the mouse cursor over the ‘No’ answer, and press and hold the left mouse
button to drag it from here over the question list to the left. As you do this you
will see the mouse pointer change, and the target question is highlighted.
Release the mouse to ‘drop’ the answer on the question ‘Have you been very
active?’. The window will now look as follows.
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& Editing new Questionnaire |Z| |E|E|

Questionnaire Name: |Cheu:k pain/activity

Question Seguence: (drag questions up or down, or back into the ‘available’ box below)  Help with conditionzl seguences

How are you fesling right now? fes
erienced any pain today 7 /
How severe was the pain? / - Drag here to redirect all answers -

Have you been very active?

Clear links from this guestion

Lorailable Questions: (drag questions from here into the seguence above to use)

: you been very active?
Have you experienced any pain today?
How are you feeling right now?
How severe was the pain?

Create MNew Question...

[+ Enable advanced mode (for conditional sequences)

Save Questionnaire Cancel

As you can see, there are now changes in the arrows to show the new question
sequence. The arrow from the ‘Yes’ answer still leads to the immediately
following question, but the arrow from ‘No’ now leads to the new target question.
So the user will move to a different next question depending on their answer at
this point. In addition, a small arrow has appear to the left of the main question
list to show an alternative sequence is present here. You can always see the
exact sequence by selecting a question to reveal the answers.

Bigger example (to present a nested set of options)
You may wish to allow the user to select from a larger number of options, but
have them organised in a logical structure rather than a longer list. One way to
present, for example, ~20 answers would be as a nested set of questions. To
ask what the user is doing right now, the answers could be divided into a number
of categories, with options within them:

Work
e Sitting at a desk
e In a meeting
¢ Manual work
e Other
e Home/Leisure
Housework/DIY
e Talking to friends/family
e Watching TV
e Qutdoor activity
e Indoor exercise
e Other
Travelling
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e Driving
e Public transport

e Walking

e Cycling

e Other
Eating

e Breakfast

e Lunch

e Dinner

e Other (small meal)
e Other (large meal)

Other
e Physically active
e Inactive

The category can then be chosen with a single ‘top-level’ question. The answer
to this then determines which category question will be shown. With questions
entered for the top-level, and each of the categories above, the questionnaire
design window looks like this:

S Editing questionnaire

(uestionnaire Name: |Current activity
Question Sequence: (drag questions up or down, or back into the "available’ box below) Help with conditional seguences
What kind of activity are you doing right now? Work
\what best descrnibes the work activity you are doing? Home/Leisure
\what best describes the home/leisure activity you are doing? Travelling
How are you travelling? Eating
\what best describes the meal you are eating? Cther
Is the other activity you are doing physically active? - Drag here to redirect all answers -

Clear links from this question

HAailable QGuestions: (drag guestions from here into the sequence above to use)

Have you been very active? ~
Hawve you experienced any pain today? F
How are you feeling right now?

Haow are you traveling?

How severe was the pain?

s the other activity you are doing physically active?

‘What best describes the homeleisure activity you are doing?

‘What best describes the meal you are eating?

‘What best describes the work activity you are doing? ¥

Create New GQuestion. ..

W Enable advanced mode (for conditional sequences)

Save Cancel

As can be seen, there are no arrows within the list because it is currently still a
straightforward sequence from top to bottom. The top question is selected, but
every answer from it is pointing at the question just below.

Next, we wish to create links so that the correct question will be jumped to next,
depending on the answer to the first question. So, using the mouse:
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e Drag the ‘Work’ answer onto the work activity question

e Drag the ‘Home/Leisure’ answer onto the home/leisure question
e Drag the ‘Travelling’ answer onto the travelling question

e Drag the ‘Eating’ answer onto the eating question

e Drag the ‘Other’ answer onto the ‘other activity’ question

The window should now look as below, showing each answer leading to a
different one of the questions below. There is also a set of arrows down the left
of the question list summarising the same thing. (The link between the 1st and
2nd question is not shown, as the list would be very cluttered if these were
always shown)

& Editing questionnaire

Questionnaire Name: |Currer|t activity

Question Sequence: (drag questions up or down, or back into the 'available’ boe below) Help with conditional sequences
\what kind of activity are i ] - Worl
Wwhat best describes the work activity you are leng'? / Home/Leisure

Wwhat best describes the homelleisure activity you are doing?
Haow are you travelling?

\what best describes the meal you are eating?

|z the other activity you are doing physically active?

- Drag here to redirect all answers -

We now need to ensure that the user will jump to the correct following question
after their ‘category question’. Otherwise they will simply step down the list and
be asked all of the questions below it. To start this, first select the ‘What best
describes the work activity you are doing?’ question. Now use the mouse to drag
the special entry at the bottom of the answers list onto the very bottom of the
guestionnaire (below the last question). You should then see this:

& Editing questionnaire |’._||’E|[z|
Questionnaire Name: |Currer|t activity
Question Sequence: (drag questions up or down, or back into the "available’ box below) Help with conditional seguences
Wwhat kind of activity are vou doing right now? Sitting &t a desk

\what best describes the work activity you are doing? In @ meeting
Wwhat best describes the home/leisure activity you are doing? Manual wark
Haowi are you travelling? Cither

what best describes the meal you are eating? - Drag here to redirect all answers -
|z the ather activity you are doing physically active?

Here, you can see that every answer to the ‘work activity’ question now points to
the line just below the bottom of the question list. This means that they will go to
the end of questionnaire straight away, with no further questions. Obviously

there could be a sequence of other questions here below the categories instead.
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Select each of the category questions in turn, and drag each of their ‘- Drag here
to redirect all answers — to below the bottom of the questionnaire. You should

now see:

& Editing questionnaire

Questionnaire Mame: |Currer|t activity

Question Sequence: (drag questions up or down, or back into the "available’ box below)

what kind of activity are you doing right now?

Wwhat best describes the work activity you are doing?

t'hat best describes the homelleisure activity you are doing?
How are you travelling?

—

Help with conditional seguences

What best describes the meal you are eating?
|5 the other activity you are doing physi

- Drag here to redirect all answers -

Physically active
Inactive

Note that this completed set shows both a set of arrows down the left from the

first question, and a set down the right leading from each of

the category

guestions to the common following point below (which happens to be the end of

this questionnaire).

Using conditional/linked questions, we now have a question
can choose between 22 different options based on a logical

naire where the user
set of categories,

rather than having to scroll through a long single list. Obviously the better choice
will depend on your application, but the Diary can support either method.

Random Ordering Example
To avoid the wearer becoming fatigued with a certain set of

guestions, it is

possible to randomize all or part of a questionnaire. To do so, first enable the
advanced mode, then click just to the left of each question to display a dice

symbol next to it. Any contiguous block of questions labelle

d with the dice will

then be placed in random order each time they are scheduled. In the example
shown below, the three central questions will be randomized, but the other

questions will not.

&3 Editing new Questionnaire

Bi=1[E3

Questionnaire Name: |I'\"Iixed random|

Question Sequence: (drag questions up or down, or back into the ‘available’ box below)

How much pain are you experiencing now, on a scale of none to th
How often have you experienced pain in the last 3 hours?

& How hungry do you feel right now?

&8 How sick do you feel right now?

Help with conditionzl seguences

MNext week, do you think you will get more sleep?

=" How sleepy do you feel now? .f__...|nn1 at all <> extremely
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5 Setting up a Diary

5.1

5.2

5.3

5.4

User Name

Schedule

Question Size

Selecting the option to ‘Set up a Diary’ from the main menu will result in a
window similar to that shown below. This shows the various setup options
available. These options will be affected by the currently opened question
database —i.e. only schedules and customisations from the current question
database will be available.

& Set up Diary...

Uszer name: |T|:|m

Schedule: |F|equest Dermo ﬂ
Optionsz:
Cuestion Size: |N|:urma|
Menu Custamisation: |Default

Enable Keplock [for weaning in pocket]

Enable Reaction Test Game

= B B B EA KN

Enable Demo Beeps [for user training]

Set up Diary Cancel

There are a number of options:

This field can be used to enter the wearer's name or any patient/volunteer ID
number you wish to be stored in the Diary to identify the wearer. It will not affect
the setup, but will be stored along with the data when the Diary is downloaded
after use.

This determines which questionnaires will be available or prompted for at what
times, once the Diary is set up. All the available schedules in the current
question database are listed. Additional schedules can be created or edited
using the ‘Edit Questionnaires’ option. The ‘Request Demo’ schedule in the
example database will make a demo questionnaire available on request as soon
as the Diary is set up.

Text can be displayed on the Diary in the standard size, or a large version. The
large option may be useful if you are working with a group of wearers who have
difficulty with the standard text size. However, it is a compromise as text will take
longer to read as it scrolls across the display.

Menu Customisation

As introduced previously, this allows translation or modifications of the standard
pieces of text in the Diary if you wish. If you have created a new customisation, it
will be available in this list. Otherwise you should select ‘Default’.
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5.5 Enable Keylock

The Diary may be carried in the pocket as an alternative to being wrist worn. In
this case you must enable this keylock to prevent accidental data entry. This will
require the wearer to smoothly run their finger across the slider before accessing
the Diary. (they may move their finger relatively quickly or slowly for this, it is
only important that they move it across the slider at a steady rate)

5.6 Enable Demo Beeps

You will normally leave this option disabled. When training your users, it may be
useful to have a ‘training’ Diary set up to demonstrate to them what will happen
when they are wearing it. If this option is enabled, then a function is created at
the right hand end of the system information menu to artificially begin a beeping
guestionnaire. When you activate this, the Diary will begin beeping just as if a
timed questionnaire had been scheduled for exactly that moment. You then
hand the Diary to the new user and talk them through responding to the
gquestionnaire. The questionnaire shown will be the first one available on request
at that point in time. If there are no questionnaires available on request, this
function will do nothing. You will probably want to combine this option with a
schedule designed just for training/demonstration.

Once you are happy with the options selected, click on ‘Set up Diary’ to set up
the Diary currently connected to the PC. Only one Diary must be connected at
this point.
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6 Using the Diary

6.1 Waking it up

The Diary is designed to be as simple and intuitive to use as possible. This
section guides you through basic use in case of any difficulty. We recommend
that you demonstrate the use of the Diary in front of each volunteer before a trial,
and then ask them to work through your questionnaire on it whilst you are
available to answer any questions. This may be easiest to arrange with a spare
‘teaching diary’ which is already set up to have a relevant questionnaire available
on request.

Once it is set up, the Diary can be woken by placing your finger across the left
hand button with the triangular icon, and leaving it there for 1-2 seconds. You
should not use any force, simply place your finger over the button for the time
required.

If the ‘keylock’ function has been enabled, you will then be prompted to swipe
your finger smoothly across the slider below the screen. You may do this quickly
or slowly and in either direction, but your finger must move at a steady speed.

6.2 Using Menus and Answering Questions

Once you have woken the Diary you can choose between options in a menu by
putting your finger on the slider and moving it around to the left or right. The
slider is always used to explore or change options, and will never actually
activate anything, so you can operate it freely without fear of changing anything.
Once you are happy with the option or answer displayed, select it by putting your
finger on the round button to the right of the screen.

6.3 Answering a Scheduled Questionnaire

When scheduled, the Diary will beep repeatedly to alert the wearer that there are
some questions to answer. They may then choose (by moving their finger across
the slider) to either answer the questions immediately, wait a few minutes, or
cancel the session entirely. As above, once they have chosen their favoured
option they simply put their finger on the right hand button to activate it.

If the wearer chooses to delay the question session for a few minutes, they can
manually re-wake the Diary at any point during that period to begin answering the
questions.

6.4 Requesting a Questionnaire

If a questionnaire has been made available on request, the user may open it
whenever they choose. It will be available in the main menu when the Diary has
been woken normally, as one of the first items in the menu (before the silent
mode and system information options). If they select it, they will begin answering
that questionnaire.

This can be used for reporting a painful incident, or exercise taken, or food eaten,
etc. Because of the nature of these events, the user can choose to enter as
many such events as they like whilst the questionnaire is available on request.
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6.5 Silent Mode

6.6 Not Waterproof

All will be recorded. This may be valuable or even essential to capture important
data.

However, be aware that it may make it more difficult to process the final results
data in a regular manner.

The Diary may be set to silent mode from the main menu after waking it. To do
this, move your finger until the ‘Enter silent mode’ option is displayed, and
activate it with the right hand button. The option will then be renamed to ‘Quit
silent mode’. This confirms that you are now in silent mode. The Diary will
remain in silent mode until the wearer activates the option again to change it
back. Obviously, you would encourage your volunteers to use this mode
sparingly, but it is a better alternative to leaving the Diary behind somewhere
(where it may be forgotten) when going to a meeting or similar.

Anybody wearing or carrying the Diary must be warned that it is not fully
waterproof, mainly due to the presence of the USB socket. With the USB bung
fitted, it will withstand accidental splashes in daily use, but it must be protected
from any greater exposure to water.

6.7 Wearing & Strap options

The PRO-Diary is designed to be worn on the wrist with replaceable fabric straps
or washable plastic straps available from CamNtech. It uses standard sprung
watch pins for the attachment so you can obtain alternative straps from any
watch supplier. Either CamNtech or your watch supplier will also be able to
assist if you are not confident inserting the spring loaded pins yourself.
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7 Downloading Results

After the end of a trial with the Diary, the results can be downloaded to your PC
for analysis. For convenience, results are stored in a database file, so that you
can keep many downloads together in one file. You can then also create a new
file when you want to group together another series of downloads. A default
results database file is created when you first use the software.

To download data, connect the Diary to the PC and click on ‘Download Results’.
The data will be downloaded to the current results database, and a popup
window will confirm when the download is finished. This is normally very quick,
and will look as shown below when successful.

I3 PRO-Diary PC Software (Version 1.0.10) =3

File  Diary  Help

L]
- - ) PRC-Diary downloaded QK -

Diovwnload the results from a PRO-Diarny into the currently open
result database.

If you wish to create a new results database you should use ‘File -> New Results
Database...’, after which the new database will be selected. You can then
change your currently selected database as you wish using ‘File -> Open Results
Database’. This setting will affect both where your data is downloaded to, and
the database which will be opened when you click on ‘Open Result Viewer'.
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8 Viewing Results

When the ‘Open Result View’ option on the main menu is clicked, the software
will display a list of all the downloaded data in the currently selected result
database. If you want to look in a different result database, use ‘File -> Open
Result Database...” before selecting the viewer option.

You can open any entry in the results list by double-clicking on it, or selecting it
then clicking ‘Open’. However, you must have a copy of the question database
which was used to set up the Diary for each entry. The software will attempt to
find this automatically when you try to open an entry; if it cannot do so then it will
ask you which question database it should look in to find the Diary setup.

Once you have opened a download, you will see results similar to the image
below. This is a table of all the answers the Diary recorded. The contents of the
table can be changed using the filtering functions described below, and the data
can then be exported using the button in the bottom right of the window. This will
create a plain text table which can be pasted directly into Excel to create a
spreadsheet of results, or used for your own analysis.

& User, "Tom', downloaded 7 January 2009 using Diary 0009.

User 'Tom’, downloaded 7 January 2009 using Diary 0009.

Wiew rezults from specific questionnaire: | EERE ST
Date Time Entry type Wwhhich colowr dopo...  How happy are wou...  which iz your favo... ‘wihat time did you ... Fioughly b
Thullan 1127 Requested  Green 0.A Lentilz 11:37 a0
Thu 1 Jan 1260 Refuzed - - - - -
Thu1Jan 1415 Scheduled  Green 0.60 Cookies 0E:29 a

Thu1Jan 1416 Refused
Thu1Jan 16:22 Refused - - - - -
Fri 2 Jan 0s:m Scheduled  Blue ne2 Steak, 0%:0 1]

Fri 2Jan 11:09 Scheduled  Red 0.55 Steak 1017 0

Fri 2 Jan 1210 Fefused - - - - -

Fri 2 Jan 1415 Scheduled  Blue 038 Cookies 1415 a

Fri 2 Jan 16 Scheduled  Red 054 Steak, 1E6:05 a

£ »
Options

(%) List entries down side () List entries across top

Show all entries v Capy table to clipboard

8.1 Filtering by Questionnaire

The table can either be used to display a row for every set of answers, or only
those from a specific questionnaire. Showing every set is comprehensive, but
does not allow the answers to be shown, as these would require different sets of
column headers. Choosing a specific questionnaire will show all the answers
given to that questionnaire. Most of the individual answers are self-explanatory,
but the visual analogue value is given as a decimal value between 0.00 and 1.00,
with the former corresponding to the left hand end of the scale and the latter to
the right hand end.
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8.2 Transposing the Results Table

Depending on the aspect of data you are looking at, it may be more convenient
to have the table arranged with a swap of columns and rows. You can choose
between these slightly different tables using the ‘List entries down side’ and ‘List
entries across top’ options.

8.3 Filtering by Scheduled/Requested

You can use the drop down list in the options area to filter just those entries
which relate to scheduled entries (even if they are refused), or only those which
the user had requested. By default, all entries are shown.

8.4 Exporting Motion Logging Data

If the Diary recording contains motion logging data in addition to the
guestionnaire results, the results window will contain a button for accessing that
additional data. This can be used to save the data for the MotionWare analysis
software (as a Motion format file), or optionally in an Actiwatch-compatible format
for analysis with your existing sleep software. The latter format will not save
some details of the file data, particularly only marking questionnaire times to a
per-epoch resolution, and having no method of marking data periods “missing”
rather than simply zero, but is adequate for most analysis. Note that you can
save in several formats simultaneously by leaving them selected. The raw
recording is also kept in the Diary software, so can be re-exported using this
method at any point.

8.5 Other Exports/Data Analysis

The data viewing and export interface is designed to be functional for those who
wish to analyse their own data. However, there are many different methods to
proceed with that analysis. If you need more assistance with your data analysis
please contact CamNtech to discuss this; we may be able to make some
arrangement to assist you.

If you are performing your own data analysis, but require clarification of the data
export or want some raw information which appears to be missing from the
export interface, please contact us.
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9 Tutorial

The PRO-Diary motion is designed to provide a flexible package combining
accurately logged subjective results with epoch-by-epoch actigraphy data. This
allows a uniquely integrated approach to data collection for sleep and lifestyle
monitoring, but inevitably makes the system slightly more complex to configure.
This tutorial leads the researcher step-by-step through a simple sleep
monitoring configuration; it is recommended that you work through it as an
introduction to the system.

The system will be set up to monitor sleep using a few features, introduced here
step by step:

e Epoch-by-epoch motion logging.
e Subjective sleep information collected at lights out and getting up times.
¢ An extra mid-afternoon questionnaire to assess sleepiness.

You can omit the motion logging if you do not need it for your application or are
using a PRO-Diary without the feature.

9.1 Create a Schedule

Start the PRO-Diary software, and click on the “Edit Questionnaires” option.
Then create a new question database using the File menu:

PR —

; .
- ] -
] Questionnaire Management O | B |

File | Edit  Add  Introduction

| Mews Question Database...

Open Question Database..
Diary Menu Custormisation..,
Refresh

Exit:

You can create the database in the default folder, or in whatever location you
choose on your computer. Putting your new work into a new database like this
simply avoids confusion with any existing questions.

Next, we will create a new “Schedule”. This is a set of instructions saying when
and how the Diary should collect data. Use the “Add” menu or right click on the
main window area to find the New Schedule function:
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(™) Questionnaire Management = 5 ﬂh]

File  Edit Add  Introduction

Cluick View:

8 Al schedules

| - B Al questionnaires
H-T7 Al questions

%I Mewe Schedule

Mewr Questionnaire

ey Question

Question Database:
Cllzers\Tom Evans\dppDatalRoaminglPatient DiandSleepDemoZ. mdb

Blue indicates that the item iz still unlocked.  Black [locked]
iterns cannot be edited, but can be copied and then changed.

—-

The software will display a blank new schedule. You should then edit the
schedule as shown below:

i — T —
[Ef] Editing new schedule [&J

Schedule name: |Sleep rnohitar

Tirne: | Questionhaire

Add new entry...

FEging [on compatiohe

v Actiwatch-compatible counts

=

|15 second epoch

Save Scheduls ‘ Cancel ‘

J

The red circle highlights the schedule name - this is fairly self-explanatory and
allows you to refer to several schedules within the question database. It must be
set to something meaningful before saving the schedule, but is not otherwise
important.

The blue circle shows settings controlling the motion logging of the PRO-Diary
device, and in this example is set to record Actiwatch-compatible counts on a 15
second epoch. This means that a single number will be recorded every 15
seconds summarising how much movement there was within that period. The
Actiwatch compatible mode is designed to recreate a compatible measure which
is already well validated for sleep use. In future software there may be additional
measures targeted more for the intensity of daytime activity.

You can now save the schedule if you wish (with no entries listed in the central
part of the window), or leave it open for now.
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9.2 Waking Up

Next, we will create a questionnaire for the user to complete after they wake up.
This both collects subjective data at the start of the day, and additionally places a
mark in the resulting actigraphy data which makes analysis easier (in exactly the
same way as the marker button on simpler actigraphy devices).

First, return to the Questionnaire Management window and use the Add menu (or
right click in the main window) to create a new Questionnaire:

Ll
] [Ej Questionnaire Management =RNT X

N1 File  Edit | Add | Intraduction
Mew Schedule

Cluick “iew:

Mew Questionnaire |

Mew Question

E T
- 57 Al questions

This will create an empty new questionnaire, as shown below. First change the
questionnaire name to “Morning” as in the red circle. This is not just the name
shown when editing, but also the name of the item which the user must choose
from the Diary menu in the morning, so it must be short and appropriate. Next
use the blue highlighted button to create a first question for the questionnaire.

- ~
@ Editing new Questionnaire oo e S
S ——
Wy
Luestionnaire M ame: |M0rning
Question Sequence: [drag qu or down, or back into the ‘available’ box below)
Available Huestions: (drag questions from here into the sequence above to use)
{* Sart alphabetically " Sort by recently added Create New Huestion... '-
B ——
[~ Enable advanced mode [for conditional sequences]
Save Questionnaire | Cancel |
= ——— — = ————1

We will simply create an example question which could be asked of a user at the
start of each day. It is best to become familiar with this interface by
experimenting with the different question types available, but for now follow step-
by-step instructions to create the question below:
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LY YuEsusan e " =
7| ™= Editing questi & Preview

= =
Huestion: Did pou gleep well? '
1 Did you sleep well?
=
Mot very well
Buestion Type: |Multiple Choice | 2
A 1100000O0000n
Great IL o
-; & 0 - T e Diary menu inthe morning, so
LD WiMat very wel 4 utton to create a first question fo
f+ Bhery badly N
- " hable more answers 3 el = d
|I:Iic:k on the left to enable more answers
» |I:Iic:k on the left to enable more answers . .
Lestionnaires
- |Elick on the left to enable more answers
it up a Dia
Preview: | Marmal test - Save Cancel ‘ p rY
{ *,-_J inload Results

Configure the parts circled in red above:

1. Type in the question “Did you sleep well?”

2. Ensure the “Multiple Choice” question type is selected

3. Select the fourth mark down on the left to enable four answer boxes to
the right

4. Fillin the answers as suggested

Note the preview window on the right. This allows you to see how well the
guestion and answers fit on the screen of the PRO-Diary. You can move your
mouse across the selection bar below the display of the Diary to show different
answers. If the preview window is not visible you can create it using the drop-
down in the bottom left of the question window.

Click “Save” in the question window to add the question to the Morning
guestionnaire. You can then continue do add more questions if you wish,
experimenting with other question types. Then save the questionnaire using the
“Save” button circled in red:
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) Editing questionnaire

-

Questionnaire Mame: |Mc-ming

Question Sequence: [drag questionz up or down, of back into the '=vailable’ box below)

Did pou gleep well?

Awailable Questions: [drag questions from here into the zequence above to uze)
Did you gleep wel?

* Sort alphabetically " Sart by recently added | Create New Question. . |

[ Enable advanced mode [for conditional sequences]

Next, we will add the “Morning” questionnaire to the schedule, so that it will be
available for the user to select in the morning. Return to the schedule window, or
double-click the schedule in the Questionnaire Management window if you had
already saved it. Then click on “Add new entry...”:

T Diay

@ Editing schedule ="
Schedule name: |Sleep ranikar
| Time | [uestionnaire |
delneuent

Create new schedule entry...

Gluestionnaire;
On Day(z)
Wwhen:

| tarning

|Ever_l,J day

" At afived time

andomly during the period belov [but only once)

109,

Cancel

-
o

The questionnaire and “Every day” options should already be set by default, and
you should set the other options. Firstly choose “On request...” which will not set
an alarm for the user but instead simply make the questionnaire available to the
user when they wake the Diary. Then set the start and finish times of the time
window it will be available for. The suggestion shown is from 5am until midday,
which may cover typical use. Then click the “OK” button to create the schedule
entry.
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9.3 Going to Bed

Next, we need another questionnaire for the user to complete just before they go
to sleep. Again, this both collects subjective data, and additionally places a mark
in the resulting actigraphy data. The steps required are as follows. Screenshots
will be similar to the “Waking Up” section above, and are omitted for brevity.

e Return to the Questionnaire Management window

e Use Add -> New Questionnaire to create a new questionnaire

o Fill in the questionnaire name “Lights Out”

e Click on “Create New Question...” in the questionnaire window

o Type “Did you feel like falling asleep at any point today?” in the question
textbox near the top of the window

o Make sure “Multiple Choice” is selected

e Click the third mark down to the left of the list of answers to open three
boxes for answers

e Type in the answers in the three boxes:

o Yes, lots
o Once or twice
o Not at all

¢ Click “Save” to save the question

¢ Add more questions if you wish using the “Create New Question...”
button.

e Click on “Save” to save the questionnaire

¢ Return to the schedule window (if necessary re-open it by double-clicking
on the schedule in the Questionnaire Management window)

¢ Create a new entry in the schedule as below:

&

»
=) Editing schedule 2
Schedule name: |SIeepM0nit0r
Day | Tire | Questionnaire |
Ewery day Ot request 05:00 - 12:00 Morning
Euenndan O reanest 12-00 - 2400 Lickbe aut
Edit schedule entry... @ I
(uestionnaire: Lights out i
On Day(s): |Evel_l,l day j
when: (" At a fised time F

" Randarnly during the period belaw [but anly once)

{* Onrequest for the whale of the period below

Fram |12:00 - to 24:00 -
Ok, | Cancel |

| | Tave | Carcel | t

- - L1 B B RS [ e

¢ Note that the new schedule entry must select the “Lights out”
questionnaire, not the “Morning” one

e The new schedule entry should be “on request” for an appropriate
evening timewindow

e Click “OK” to create the new schedule entry
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9.4 Afternoon Tiredness

If you wish, you may now also create a questionnaire to monitor sleepiness in the
afternoon. The questionnaire may be created following a similar procedure to the
above. The schedule entry would be different, such as this:

l Edit schedule entry... . @
Luestionnaire: |,-’.'a.ftemn.:.n j j
On Daylz): |Every day ﬂ
when: (" At a fired time

{* Randomly during the period below [but only once)

" On request for the whale of the period below

From |15:00 - to
ok | Cancel

The “Randomly during the period below” function allows you to avoid consistently
clashing with the user doing a particular activity at a precise time. Alternatively
you can schedule it for a fixed time using the option above. The user can in
either case choose to delay the prompt by a few minutes before they answer it.

9.5 Using the Schedule

After following the instructions so far, you should have a finished schedule which
looks similar to this:

) Editing schedule [ |

Schedule name: |Sleep iohitor

Day | Tirme | [uestionnaire
Ewer day Ornrequest 05:00 - 12:00 Morning
Ewvery day Onrequest 12:00 - 24:00 Lights out
Ewem day Ab15:30 Afternioon

Add new enty.

kotion Logaing [on compatible productz)

v Actiwatch-compatible counts

|15 second epoch ﬂ

Save Cancel

You should use the “Save” button to save this schedule, and can now close the
Questionnaire Management window entirely.

Connect a PRO-Diary Motion to the PC, and click on the “Set up a Diary” button
to configure it:
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' @ Set up Diary... ﬁ

[Jzer name: |Tom

Schedule: |Sleep rnanitor j
Opticrs:

Guestion Size: |N0rmal

Enable Kevlock [for wearing in pocket]
Dizable Silent Mode

Remave "Spstem Information' Menu

=

Menu Customisation: |Default j
r

r

=

-

Enable Demo Beeps [far uzer training)

Set up Diay | Cancel

Enter the User name as you wish, and ensure the Sleep monitor schedule you
have created is selected. You need not select any of the other options — consult
the normal PRO-Diary Guide to Getting Started for more information. Then click
on “Set up Diary”; the software will confirm when it is set up after a minute or two.

Now wear the Diary on the wrist for a few days. After waking up in the morning:

¢ Hold your finger over the button to the left of the display for a few seconds
e Move your finger on the to select “Morning” in the display

e Select using the button to the right of the display

¢ Answer the morning question(s)

You can then continue to wear the Diary throughout the day, and follow similar
instructions to select the “Lights out” questionnaire before going to sleep in the
evening. If you have also added the afternoon entry as suggested, then the
Diary will beep at you to begin that questionnaire.

When wearing the Diary, you can check the time at any point simply by holding
your finger over the button to the left of the display for a few seconds. Place your
finger there again to turn the display off again. In this way the Diary can be worn
in place of a user’s normal watch if they wish.

9.6 Downloading Results

To download the results from the Diary, first plug it into the PC and start the
PRO-Diary software. Click on the “Download Results” option from the main
menu. Confirm if you wish to save to the current results database (doesn’t
matter for testing, but create a new results database for a genuine study).

Next click “Open Result Viewer” and then double-click on the relevant recording
which should be at the top of the list of results. This will allow you to see the
normal Diary results table (see elsewhere in the User Manual for more details),
but also contains a button in the top right to export the motion logging results:
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From this window, you can choose to save the motion data for use in the
MotionWare analysis software (as a Motion format file), or optionally in an
Actiwatch-compatible format for analysis with your existing sleep software. The
latter format will not save some details of the file data, particularly only marking
guestionnaire times to a per-epoch resolution, and having no method of marking
data periods “missing” rather than simply zero, but is adequate for most analysis.
Note that you can save in several formats simultaneously by leaving them
selected. The raw recording is also kept in the Diary software, so can be re-
exported using this method at any point.

9.7 Demonstrating a Timed Questionnaire

We would recommend that before giving any new wearer the PRO-Diary, you
first demonstrate to them how to operate the device. This is easiest using a
spare device already set up with a single questionnaire on request, and selecting
the “Enable Demo Beeps” option during setup. You can then show them:

¢ How to turn on the device by holding their finger over the left button.

e That this allows them to read the time.

e How to select one of the currently available questionnaires, such as
Morning.

¢ Lead them through answering all the questions in that questionnaire.

¢ How the Diary will appear when it is beeping for a timed questionnaire.
This can be demonstrated by:

Take the Diary from the wearer

Wake it using the left button

Select the right-most option “System Information” and select it

Select the right-most option “Timed demo” and select it

Hand the Diary back to the wearer as it beeps

Explain how they can then choose either the OK, In a few

minutes, or Cancel option

o O O O O O

It is usually preferable to perform this demonstration using a version of one of the
questionnaires they will later receive so that they can see both the operation of
the Diary and the nature of the questions they will be asked at the same time.
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10 Frequently Asked Questions

What limits the recording life?
The battery is used mainly whilst the display is on and the user is actually
answering questions. When the battery is brand new and fully charged, it will run
for around 10 hours of continuous questioning, equivalent to about 20 minutes
per day for one month. However it is possible to design a questionnaire which
will take more or less of the wearer’s time than this.

Will too many answers fill up the memory?
No, the answers to questions do not take up a significant part of the memory.
Short epoch motion data will take much more memory, but in most cases the
recording time will be limited by battery life rather than memory.

Will the data be lost if the battery runs flat?
No. Plug the device into a USB port to recharge for an hour or so, and try to
download again. If you still have difficulty recovering data, contact CamNtech
before doing anything else with the Diary. We will do our best to recover data
even from badly damaged devices.
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11 Additional Documents

Subsections of this user manual are provided for quick reference from the PRO-
Diary software. In addition, the document below is provided and can be found
from the windows Start Menu once the Diary software is installed.

Templates for Cue Cards
Depending on your users, you may consider printing out and laminating these

credit-card sized guides to give out with the Diary. These include a few hints to
operate the Diary. You might wish to modify them as desired for your
application.
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12 Safety and Handling Information

12.1 De-contamination

e Devices used in the field must be considered to be contaminated.

e Returned devices must be cleaned with alcohol wipes to minimise any
potential contamination. The operator must use gloves to handle such
devices before and during de-contamination.

12.2 Battery
e The device is battery operated and operates at voltages below 5VDC;
there is hence no risk from electric shock (equipment Type B).
e The battery is NOT user replaceable.

12.3 Water Ingress

e The PRO-Diary is not waterproof. When the USB bung is fitted, it should
withstand accidental splashes in daily use, but the Diary must be removed
before any greater exposure to water.

12.4 Disposal

Waste Electrical and Electronic Equipment Directive 2002/96/EC, that
manufacturers and/or distributors of Electronic and/or Electrical Equipment

EEEEE manage and pay for the collection and further handling of WEEE products, as
well as provide WEEE-related information to their customers.

E Waste Electrical & Electronic Equipment (WEEE) The EU requires, under the

CamNtech has taken the following approach to complying with this Directive:

e CamNtech has registered with an approved producer compliance scheme
(PCS) in accordance with the requirements of the WEEE Directive.

e CamNtech will provide free recycling for all of its WEEE products when
returned to CNT.

e CamNtech WEEE products will be designed with recycling, reuse and
waste management as a consideration.

e CamNtech WEEE products will be labelled or stamped with the WEEE
marking in accordance with European Standard EN 50419.
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Issue Issue Date Description Initiator
From To
1.1.14 1.1.15 04/12/13 Added Australian Sponsor Details HS
1.1.15 1.1.15a 10/12/13 Updated indications for use to align with FDA submission HS
1.1.15a | 1.1.15b 03/03/14 Updated FDA clearance status HS
1.1.15b 1.2.1 10/02/15 Minor updates to match software changes TE
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